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S

C
Y

dling procedures will 

Do not subject to 
excessive force or 
impact.

Keep away from 
excessive 
moisture.

Do not dismantle.
Saf

afety and Handling Instructions

aring For 
our Player 

While your player is quite robust, observing these han
prolong its life.

Do not store or 
use in areas 
exceeding 45ºC 
or 113ºF.

Do not expose to 
heat or incinerate.

Keep away from 
strong magnetic 
fields.
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B
P

 note of these 

Avoid contact with 
metal objects like 
keys or 
necklaces.

Store away from 
direct sunlight.

Do not store or 
use in areas 
exceeding 45ºC 
or 113ºF.
Safe

attery Usage 
recautions 

When charging or handling your player’s battery, take
precautions:

Never modify or 
disassemble the 
battery. If there is 
leakage, stench, 
discoloration or 
deformation during 
charging or use, 
remove the battery and 
do not use it again. 
Clean your hands well 
before  handling food 
or touching sensitive 
areas of your body, for 
example, your eyes.

 

Do not expose to 
heat or fire.

Do not pierce or 
crush.

Avoid contact with 
moisture.
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I
rchasing the Creative 

tweight, just about 8.0 
 a normal portable 
the player’s music 
 2.0™ connector, so 

sily. 

n Xtra features an 
a real-time effects 
ion. Your player also 
with Advanced EQ 
effects. Your portable 
, including MP3, WMA 
ntroduction 
Congratulations on making an excellent decision in pu
NOMAD Jukebox Zen Xtra! 

Your new multi-format portable player is extremely ligh
ounces (226 grams). Even though it is no bigger than
cassette player, you can store thousands of songs in 
library.  Your player also comes equipped with an USB
you can transfer audio tracks and data quickly and ea

Unlike other hardware-based players, the NOMAD Ze
onboard real-time digital signal processor (DSP) and 
processor for superior audio playback and customizat
supports EAX™ so that you can enhance your audio 
presets, headphone spatialization, environments and 
digital audio player supports multiple audio file formats
and WAV.

The product name may 
vary from country to 
country.
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B

P
C

H  battery)

S

efore You Begin

ackage 
ontents

ardware ❍ NOMAD Jukebox Zen Xtra Player (with removable
❍ AC Power Adapter
❍ Installation CD incorporating PDF User’s Guide
❍ Quick Start leaflet
❍ Stereo headphones
❍ USB cable
❍ Protective pouch
❍ Lithium-ion rechargeable battery

oftware ❍ Creative MediaSource Player
❍ Creative MediaSource Organizer
❍ Creative NOMAD Explorer
❍ Adobe Acrobat Reader
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C
M
P

 will need for music 
yers, Creative 
he power of NOMAD 

MA, WMV, NVF, 

 effects using EAX
the pitch (Time 

 of songs at a similar 
t different loudness 

nd Creative 

C
M
O

es can be a headache. 
ny track easily, no 
 storage devices.

r Audigy 2 audio card installed
reative 
ediaSource 
layer

Creative MediaSource Player is the only software you
and multimedia entertainment. Unlike other media pla
MediaSource Player is specially designed to access t
Jukebox Zen Xtra’s hardware. With it, you can:
❍ play back music and multimedia files: MP3, WAV, W

VideoCD, etc*
❍ enhance playback of ordinary music with surround
❍ vary the speed of audio playback without affecting 

Scaling)*
❍ use Smart Volume Management to play back a list

volume level even if they were originally recorded a
levels*

❍ switch between Creative MediaSource Organizer a
MediaSource Player with just a click of the mouse

reative 
ediaSource 
rganizer

Managing a huge collection of audio CDs and MP3 fil
With Creative MediaSource Organizer, you can find a
matter where it is stored on your hard disk or external

* To enjoy this feature, you must have a Creative Sound Blaste
in your system.
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C
E

yer’s audio tracks and 

 organize and transfer 
x, or between different 
, such as Drag-and-

th Microsoft Windows 
d from your player, just 

acks to  your player's 
our player's Music 
io track management 
Creative MediaSource 

A
R

 and print Adobe 
mputer platforms. 
reative NOMAD 
xplorer

 Creative NOMAD Explorer helps you manage your pla
data files within Windows® Explorer. 

With Creative NOMAD Explorer, you can conveniently
files between your computer and your NOMAD Jukebo
NOMAD Jukeboxes, using familiar Windows methods
Drop and Cut-and-Paste.

As Creative NOMAD Explorer has been integrated wi
Explorer, you can easily copy or move data files to an
like a portable storage device.

Creative NOMAD Explorer also lets you copy audio tr
Music Library. However, you will not be able to view y
Library with Creative NOMAD Explorer. For more aud
options for your player, it is recommend that you use 
instead.

dobe Acrobat 
eader

Adobe Acrobat Reader is a software that lets you view
Portable Document Format (PDF) files on all major co
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M
S
R

dows 2000, Windows 

z or better processor 
P3 encoding)

Sound Blaster 

ng audio)
g and CDDB2™ 

y of the user)

olution or better)
inimum 
ystem 
equirements 

❍ Microsoft® Windows® 98 Second Edition (SE), Win
Millennium Edition (Me) or Windows XP

❍ Intel® Pentium® II 233 MHz, AMD®-K6-2® 266 MH
(Pentium III 450 MHz or higher recommended for M

❍ Sound Blaster Live!™, Sound Blaster Audigy™ or 
Extigy™ for EAX enhanced MP3 encoding

❍ CD-ROM drive with digital audio extraction support
❍ USB 1.1 or 2.0 port
❍ 64 MB RAM (128 Megabytes recommended)
❍ 30 MB free hard disk space (more needed for stori
❍ Internet connection for Internet content downloadin

support (any charges incurred are the responsibilit
❍ Installed mouse
❍ SVGA graphics adapter (256 colors, 800 x 600 res

The software 
applications on the 
installation CD may 
have higher 
requirements for 
basic functionality. 
Refer to each 
application’s 
documentation for 
details
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D
C

 for you:

 relating to a feature.

nt information about 

your player. Use this 
sk.

ards to yourself or 
damage.
ocument 
onventions

We use icons to highlight useful or urgent information

 

Tip. This tells you about shortcuts or hints

Note. This highlights additional or importa
a feature.

Caution! This highlights proper usage of 
information to avoid situations involving ri

Warning! This warns you of possible haz
your player, which may result in injury or 
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W
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 on:
eb 
nformation 

Visit www.NOMADworld.com regularly for information
❍ firmware updates
❍ NOMAD accessories 
❍ tips and tricks
❍ FAQs
❍ troubleshooting
❍ documentation updates
❍ software updates or purchases
❍ technologies used in your player
❍ an online glossary
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O
A

se accessories.

ith a Cassette 
ts your player to a 

tional removable 
or your battery.
ptional Player 
ccessories

Visit www.NOMADworld.com to learn more about the

❍ The Car Kit comes w
Adapter that connec
car cassette player.

❍ You can get an addi
Lithium-Ion battery f

Car Kit

Removable battery
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R

uring installation, or at 
nline 
egistration

Enjoy a host of benefits by registering your products d
www.creative.com/register. 

Benefits include: 
❍ Service and Product support from Creative.
❍ Exclusive updates on promotions and events!

To register online, 
your player must 
be connected to the 
computer.
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A

Y
a

USB connector
connects a USB cable 
from your player to 
your computer to 
transfer data or audio 

ector

LCD screen 

ter 
 Tour of Your Player

our Player at 
 Glance

Headphones conn
connects to your 
headphones.

Menu button 

Play/Pause 
button

Forward/Reverse 
button

Scroller 

Back 
button 

Power adap
connector

Power 
button 

Reset 
button 

Volume 
button 

Open switch
To change or insert the 
battery, push the switch 
to the right to open your 
player’s cover.
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U
S

S our NOMAD Jukebox 
croll Select”, to 

ugh options and then 

ferent menu options. 
tion box.

ress the Scroller to select an 
ption
sing the 
croller

croll Select The Scroller is one of the most important features of y
Zen Xtra. In this document, we will use a new term, “S
indicate that you should use the Scroller to scroll thro
select the option by pressing the Scroller.

Depending on the screen you are in, you can have dif
You can also choose options from a list or a confirma

To "Scroll Select", 
use the Scroller to 
scroll to the option 
you want, and select 
the option by 
pressing the Scroller.

Use the Scroller to scroll 
through options

P
o

The Scroller 
(side view)
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S
o

. For example, if you 

u.

S
c
o

xes or options in a list.

n

Unlocking the player
electing menu 
ptions

You can use the Scroller to make selections in menus
are looking at the Menu screen:

1. Use the Scroller to scroll up and down in the men
2. Press the Scroller to select the menu item.

electing list and 
onfirmation box 
ptions

You can also use the Scroller to select confirmation bo

1. Move the Scroller to scroll through the options. 
2. Press the Scroller to select the option.

From the Menu screen to the Settings scree

Scroller options

Constructing a title from a list
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sage Tips

hold until player turns 

layer is turned on, 
utton. The Lock 

ndow appears. Use 
 and select the check 

ard or go back to 
ck, press the Menu 
 then Scroll Select 
usic to get to the 
usic screen. Use the 
 select the track you 

p to.

ack from the Music 
eens, press and hold 
Button What It Does U

POWER

❍ turns the player on and off
❍ disables all buttons except for the scroller
❍ activates LCD backlight

❍ press and 
on or off

❍ when the p
press this b
player? wi
the scroller
mark icon.

MENU

❍ accesses most of your player’s features

FORWARD/
REVERSE

❍ skips to the next track
❍ skips forward to portions of a track when 

you press and hold the button
❍ skips to the beginning of the current track, 

or to the previous track
❍ skips to previous portions of a track when 

you press and hold the button

❍ to skip forw
another tra
button, and
Selected M
Selected M
scroller and
want to ski

PLAY/PAUSE

❍ starts, pauses, or continues playback
❍ to play a tr

Library scr
this button.
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hold the end of 
to increase the 
ckly

hold the end of 
to decrease the 
ckly

roller to scroll through 
ns and press the 
select them. This 
so referred to as 
ct".

acks continuously, 
roller until you reach 
at you want.

nd of a thin object, 
r clip, into the button

sage Tips
VOLUME  

❍ increases the volume 

❍ decreases the volume

❍ press and 
the button 
volume qui

❍ press and 
the button 
volume qui

SCROLLER 

❍ scrolls up and down menus
❍ selects menu options

❍ turn the Sc
menu optio
Scroller to 
action is al
"Scroll Sele
To Scroll tr
hold the Sc
the track th

BACK 

❍ goes to previously accessed screens

RESET  
❍ resets your player if it stops reponding ❍ insert the e

like a pape

OPEN SWITCH ❍ To change or insert the battery, push the 
switch to the right to open your player’s 
cover.

Button What It Does U
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G

I
b

ure 2-1. The cover 

shown in Figure 2-2.

Open switch

r.
etting Started

nserting the 
attery

1. Push the Open switch to the right as shown in Fig
pops open.

2. Insert the battery into your player.
3. Position the hooks of cover over the openings as 

Figure 2-1: Opening the cover.

Hook

Opening

Figure 2-2: Positioning hooks of cove
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igure 2-3.
4. Press the cover gently to snap shut as shown in F

Figure 2-3: Securing the cover.
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C
B

h your player needs to 
in battery charger will 
btain the maximum 

).

 fully charged.
wer socket

socket.
harging the 
attery

The high performance lithium-ion battery supplied wit
be fully charged before you use it. Your player’s built-
fully charge the battery (in approximately 4 hours) to o
playback time. To charge your player’s battery:
1. Connect your player to the wall outlet (Figure 2-4

Your player will turn itself on.
2. Check the battery icon to see when the battery is

AC adapter connector

Po

Figure 2-4: Connecting the player to a power 
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P
a
I

ding on the battery’s 
cal power).

Notes

tate icon shows that 
s fully charged

 battery at the earliest 

attery fully before 
g the player from the 

ng, the icon will 
tween this icon and a 
 icon, showing the 
 level of charge

ry power, disconnect 
om the power outlet
ower Source 
nd Level 

ndicators

Your player displays one of the following icons, depen
charged status or the power source (battery or electri

Icon What the icon means

❍ your player is running from electrical 
power only

❍ your player is running from battery power 
only

❍ this battery s
the battery i

❍ your player’s battery is 60% full

❍ your player’s battery is 30% full ❍ recharge the
opportunity

❍ your player is running from electrical 
power and is charging the battery

❍ charge the b
disconnectin
power outlet

❍ while chargi
alternate be
battery state
approximate

❍ your player is running from electrical 
power and has finished charging the 
battery

❍ to use batte
the player fr
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I
S

s you create audio 
r. 

ur computer.
.
ode and starts 

our CD-ROM drive's 
ee "AutoPlay" on page 

Zen Xtra option to 

 that you will be 

e CD in the CD-ROM 
y computer now 

n.
nstalling 
oftware

Your NOMAD Zen Xtra comes with software that help
tracks, manage your music library and use your playe

1. Make sure that your player is not connected to yo
2. Insert the Installation CD into your CD-ROM drive
3. The Installation CD supports Windows AutoPlay m

running automatically. If not, you need to enable y
auto-insert notification feature. For more details s
C-1.

4. Click the Install software for NOMAD Jukebox 
select it.

5. Click the OK button.
6. Click the Next button to register with Creative, so

updated on new developments for your Jukebox.
7. Follow the onscreen instructions.
8. When prompted to restart your computer, leave th

drive, and then click the Yes, I want to restart m
option to select it.

9. Click the Finish button to complete the installatio

You must restart your 
computer before trying 
out any of the installed 
applications.

You can also select the 
language that your 
player’s screens 
appear in. See 
"Language Settings" 
on page D-3.
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C
y
y

puter. Your NOMAD  
t data transfers to and 
reative MediaSource 
onnecting 
our Player to 
our Computer

You are now ready to connect your player to your com
Jukebox Zen Xtra comes with a USB 2.0 cable for fas
from your computer. Be sure that you have installed C
before connecting your player.

You can listen to your 
player’s preloaded 
music immediately by 
pressing the Play 
button. 

Basic instructions on 
how to use Creative 
MediaSource are 
provided in "Using 
Creative MediaSource" 
on page 4-2. 
Basic instructions on 
how to use File 
Manager are provided 
in "Using NOMAD 
Explorer" on page 4-7.

USB port
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T
M

to get you started 
ply press the Play 

cks to your player, you 
 sites (see 
 them "ripped" from 

rted formats (MP3, 
ayer with Creative 

layer. For example, 
uter to another. Data 
MAD Explorer 
ransferring 
usic

Audio selections have been preloaded to your player 
quickly. If you wish to listen to music immediately, sim
button . 

However, if you wish to download additional music tra
can either download music tracks from Internet music
"Downloading from the internet" on page 2-8) or have
audio CDs to your computer. 

Music files must, however, be encoded into the suppo
WMA or WAV file formats), then transferred to your pl
MediaSource Organizer.

Data files can also be transferred and stored in your p
you want to transfer a large movie file from one comp
can be transferred to your player with the Creative NO
application.
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D
f

e to locate sites with 
tes listed here are 

usic files to your 

R
C

dio data from an audio 
rive that can extract 
With Creative 
 audio CDs. This 
cks from the audio CD 

pends on:

w.amp3.com

om
w.artistone.com

.com
w.soundbuzz.com
ownloading 
rom the internet

To get MP3 files from the Internet, use a search engin
MP3 content. You can also try out these sites (web si
correct at the time of this document’s release):

Follow the instructions on the site and download the m
computer.

ipping from a 
D

The first phase in making an MP3 file is extracting au
CD. To extract audio data, you will need a CD-ROM d
digital audio data, and a program known as a Ripper. 
MediaSource Organizer, you can rip tracks from most
program uses the CD-ROM drive to read the audio tra
and stores it on your hard disk. 

The time needed for a successful audio extraction de
❍ CD-ROM drive speed
❍ defects, like scratches on the audio CD
❍ error-checking features on the CD-ROM drive

It is illegal to encode 
MP3 files for trade or 
sale unless you have 
the express or explicit 
permission of the 
copyright holder(s).

❍ NOMADWorld 
http://www.NOMADworld.com

❍ AMP3.com
http://ww

❍ SoundClick.com
http://www.soundclick.com

❍ ArtistOne.c
http://ww

❍ Epitonic.com
http://www.epitonic.com

❍ Soundbuzz
http://ww
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 Encoders are used to 
o MP3 files. MP3 
ans that some data is 
 sampling rate and 
their audio quality. The 
gh some are set 
n larger MP3 file sizes, 
rganizer to extract 

elp for more 
Encoding is the second phase of making an MP3 file.
convert the stored audio tracks, usually WAV files, int
encoding is considered lossy compression, which me
lost during compression. However, using the standard
bitrates will ensure that your MP3 files retain much of 
standard bitrate of most MP3 files is 128 Kbps, althou
higher, at 160 or 192 Kbps. Higher bitrates will result i
with better audio quality. Use Creative MediaSource O
audio tracks and encode MP3s. 

See the Creative MediaSource Organizer online H
information.
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P

P

M ukebox Zen Xtra have 
ly.

tra’s Music Library to 
ng Music Tracks to the 
 entire Selected Music 

sic Library, see "Using 

P
S

cted Music List is 
Playing

laying and Managing Your Music

laying Music

usic Playback Audio selections and an Audio Tour of your NOMAD J
been preloaded to your player to get you started quick

You can add audio selections from the NOMAD Zen X
the player’s Selected Music List as described in "Addi
Selected Music List" on page 3-10, then play back the
List.

To add audio tracks to NOMAD Jukebox Zen Xtra’s Mu
Creative MediaSource" on page 4-2.

laying the 
elected Music List

Follow these steps to play the Selected Music List.

1. Press the Play button . 

The Play icon  appears onscreen and the Sele
played back, from the first track to the last.

2. Press the Menu button . 
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er of the screen will 

 screen.
k that is being played 
er-left corner of the 

P
y

.

r player are 
d are played back 

Selections

ed Time Bar

 Title
Playing

3. Scroll Select Selected Music. The upper-left corn
display the Selected Music List icon.

4. Press the Back button again to display the Menu
5. Scroll Select Now Playing, which shows the trac

back or the track that has been selected. The upp
screen will display the Now Playing icon.

laying all tracks in 
our player

Follow these steps to play all audio tracks in your player

1. Press the Menu button .
2. Scroll Select Music Library.
3. Scroll Select Play any track. All the tracks in you

automatically added to the Selected Music List an
randomly.

Audio 

Selected Music 
List icon

Album Title

Elaps
Now Playing 
Icon

Track

Genre
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P  how your Selected 

de as described in 

R  Selected Music List.

orresponding step:

d the track is repeated 
Playing

lay Modes Your player has Play Modes that allow you to change
Music List is played back. 

The following Play Modes are available:
❍ Repeat track
❍ Repeat all
❍ Shuffle
❍ Shuffle repeat
❍ Track once
❍ Normal

Play Modes are disabled by enabling the “Normal” mo
"Normal mode" on page 3-6. 

epeating music You can choose to repeat a track or repeat the whole

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.
3. Press the Scroller. A list appears.
4. Scroll Select Play Mode.... A list appears.
5. Depending on which mode you want, follow the c
To repeat a track in the Selected Music List

Scroll Select Repeat track. 
The Repeat Track icon  appears onscreen an
continuously until you stop it. 

If there is only one 
track in the Selected 
Music List when 
"Repeat All" is 
enabled, that track 
will be repeated 
continuously.
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he Selected Music List 

S r continuously (“Shuffle 

orresponding step:

ack is selected at 
t stops playing once all 
ack once.
Playing

To repeat the whole Selected Music List

Scroll Select Repeat All. 

The Repeat All icon  appears onscreen and t
is repeated continuously until you stop it.

huffling music The Shuffle Play Mode can be used once (“Shuffle”) o
Repeat”).

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.
3. Press the Scroller. A list appears.
4. Scroll Select Play Mode.... A list appears.
5. Depending on which mode you want, follow the c
To Shuffle the Selected Music List once

Scroll Select Shuffle. 
The Shuffle icon  appears onscreen and a tr
random and played back. The Selected Music Lis
the tracks in the Selected Music List are played b

If there is only one 
track in the Selected 
Music List when 
"Shuffle Repeat" is 
enabled, that track 
will be repeated 
continuously.
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inuously

nd tracks are selected 
 stop playback.

P
o

h track in the Selected 
wever, when the Track 
 current track ends.

 appears onscreen. 
ack ends.
Playing

To Shuffle Repeat the Selected Music List cont

Scroll Select Shuffle Repeat. 
The Shuffle Repeat icon  appears onscreen a
at random and played back continuously until you

laying a track 
nce

When the Selected Music List is played normally, eac
Music List is played, from the first track to the last. Ho
Once Play Mode is enabled, playback stops once the

1. Press the Menu button .
2. Scroll Select Now Playing.

The Now Playing screen appears.

3. Press the Scroller. A list appears.
4. Scroll Select Play Mode.... A list appears.

5. Scroll Select Track Once. The Track Once icon 
The Selected Music List stops playing once the tr
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N elected Music List is 

ys back normally.

B
t

jump to this point 
ful if, for example, you 
Playing

ormal mode Once the Normal mode is enabled, each track in the S
played, from the first track to the last.

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.
3. Press the Scroller. A list appears.
4. Scroll Select Play Mode.... A list appears.
5. Scroll Select Normal. The Selected Music List pla

ookmarking a 
rack

Bookmarking a track sets a playback point—you can 
whenever you play the bookmarked track. This is use
want to bookmark an audio book.

1. Press the Menu button .
2. Scroll Select Now Playing.

The Now Playing screen appears. 

3. Press the Scroller. A list appears.

A track can only be 
bookmarked once; 
setting a new 
bookmark will 
automatically 
remove any previous 
bookmark in the 
track.
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orresponding step:

u want to set the 
at the bookmark has 

om the bookmarked 

ssage box appears, 

O
y

ould be familiar with 
ists are. These will be 
Playing

4. Depending on which mode you want, follow the c
To bookmark a track

Scroll Select Set Bookmark at the point where yo
bookmark. A message box appears, telling you th
been set at the selected point.

To play the track from the bookmarked point

Scroll Select Go to Bookmark. The track plays fr
point.

To remove a bookmark

Scroll Select Clear Bookmark (see below). A me
telling you that the bookmark has been cleared.

rganizing 
our Music

To effectively manage the music in your player, you sh
what the Music Library, Selected Music List and Playl
described extensively in the following sections:
❍ "Using the Music Library" on page 3-8
❍ "Using the Selected Music List" on page 3-14
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U
M
L

 are organized into the 

category, but 
cks can also be found 

k called "Toffee Apple 
undtrack to the movie 
ple Smile" song would 
rom The Big Sneeze" 

n only be found in the 
:

Playing

sing the 
usic 
ibrary

When audio tracks are transferred to your player, they
following Music Library categories:
❍ Playlists
❍ Albums
❍ Artists
❍ Genres
❍ All Tracks

All transferred tracks can be found in the "All Tracks" 
depending on your Creative MediaSource settings, tra
in other categories. For example, take a fictitious trac
Smile", performed by "The Nano Singers", from the so
"The Big Sneeze". Besides "All Tracks", the "Toffee Ap
also be found in the "Soundtrack" genre, the "Songs f
album, and the "The Nano Singers" artist category.

Tracks not belonging to any album, artist, or genre ca
“Unknown” category. You can use the Music Library to
❍ Add audio selections to the Selected Music List
❍ Find tracks, playlists, albums, artists or genres 
❍ View track information
❍ Delete tracks, playlists, albums, artists or genres
❍ Preview a track

To transfer audio 
tracks to NOMAD 
Jukebox Zen Xtra’s 
Music Library, see 
"Using Creative 
MediaSource" on page 
4-2.

Modifying or renaming 
albums, artists, or 
genres must be done 
in Creative 
MediaSource. Only 
Selected Playlists can 
be renamed in the 
player.
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F
T
M

d a track by navigating 

ou want to find a track 

r Albums, Scroll Select 

egory appear.
Playing

inding a Music 
rack in the 
usic Library

In the following example, you will be shown how to fin
through your Music Library.

1. Press the Menu button .
2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if y

in a particular album, Scroll Select Albums.
Note: If Scroll Selecting All Tracks, go to Step 5.

4. Scroll Select the sub-category. For example, unde
an album title. A list appears.

5. Scroll Select Open. The tracks within the sub-cat
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A
T
S
L

 added sequentially 
dd to Play") or placed 
layback ("Play Now").

ou want to add a track 

r Albums, Scroll Select 

ylist, skip to step 6.
Playing 

dding Music 
racks to the 
elected Music 
ist

Audio selections from the Music Library can either be
after selections already in the Selected Music List ("A
at the front of the Selected Music List for immediate p

1. Press the Menu button .

2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if y

in a particular album, Scroll Select Albums.

4. Scroll Select the sub-category. For example, unde
an album. A list appears.
Note: If adding an entire album, artist, genre or pla
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egory appear.

ion to the back of the 

  to add the 
d immediately play it 

V
I
t

 is readily available. 
that the track belongs 

Library

ou want to find a track 

 list appears.

Playing 

5. Scroll Select Open. The tracks within the sub-cat

6. Scroll Select Add to Play to add the audio select
Selected Music List. 

7. Scroll Select Play Now or press the Play button 
selection to the front of the Selected Music List an
back.

iewing Track 
nformation in 
he Music Library

Detailed information about tracks in the Music Library
This includes the track’s title, artist, album and genre 
to, as well as the track’s length.
To view information about tracks in the Music 

1. Press the Menu button .
2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if y

in a particular album, Scroll Select Albums.
4. Scroll Select the track you want information on. A
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ars, listing track 

D
T
M

s, genres or Selected 

ou want to find a track 

ppears.
Playing 

5. Scroll Select Track Details. A message box appe
information.

eleting Music 
racks from the 
usic Library

This action permanently deletes tracks, albums, artist
Music Lists from  your NOMAD Jukebox Zen Xtra.
To delete a track

1. Press the Menu button .
2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if y

in a particular album, Scroll Select Albums.
4. Scroll Select the track you want to delete. A list a
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pears, asking you if 

r.

cted Music List

ou want to delete a 
Playing 

5. Scroll Select Delete Track. A confirmation box ap
you want to delete the selected track.

6. Scroll Select the check mark . 
The track is permanently deleted from your playe

To delete an entire album, artist, genre or Sele

1. Press the Menu button .
2. Scroll Select Music Library.
3. Scroll Select an audio category. For example, if y

particular album, Scroll Select Albums.

4. Scroll Select Open.
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r Albums, Scroll Select 
epending on what you 
Artist, Delete Genre 
king you if you want to 

.

st, genre or playlist is 

U
S
M

lected Music List. You 

t

V
t
S
L

e Selected Music List, 
see these tracks, you 
 hide these tracks, you 
 be useful in reducing 
Playing 

5. Scroll Select the sub-category. For example, unde
the album title you want to delete. A list appears. D
are deleting, Scroll Select Delete Album, Delete 
or Delete Playlist. A confirmation box appears, as
delete the selected album, artist, genre or playlist

6. Scroll Select the check mark . The album, arti
permanently deleted from your player.

sing the 
elected 
usic List

You can do more than play audio selections in the Se
can:
❍ View audio in the Selected Music List
❍ View information about tracks in the Selected Music Lis
❍ Remove audio
❍ Rearrange the Selected Music List
❍ Save the Selected Music List as a playlist

iewing music 
racks in the 
elected Music 
ist

When entire albums, artists or genres are added to th
the tracks within them are hidden (or "collapsed"). To 
must "Expand" the album, artist or genre. Similarly, to
should "Collapse" the album, artist or genre. This can
screen clutter.

You can also view 
track information 
from the Selected 
Music List. See 
"Viewing track 
information in the 
Selected Music List" 
on page 3-16
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 A list appears.
appear beneath the 
Playing 

To expand an album, artist or genre

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.

3. Scroll Select the album, artist or genre to expand.
4. Scroll Select Expand. The tracks in the selection 

album, artist or genre.

To collapse an album, artist or genre

1. Press the Menu button .
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 A list appears.
 expanded album, 

V
i
S
L

n be easily accessed 
at described in "To 
 page 3-11.

ing.
ected Music List or 

 the track that you want 
Playing 

2. Scroll Select Selected Music.
The Selected Music List screen appears.

3. Scroll Select the expanded album, artist or genre.
4. Scroll Select Collapse. Tracks within the formerly

artist or genre are hidden.

iewing track 
nformation in the 
elected Music 
ist

Information about tracks in the Selected Music List ca
and viewed. The information provided is identical to th
view information about tracks in the Music Library" on

1. Press the Menu button .
2. Scroll Select either Selected Music or Now Play

Track information can be viewed in either the Sel
Now Playing screen.

3. On the Selected Music List screen, Scroll Select
to view information about.
On the Now Playing screen, press the Scroller.
In either case, a list appears.



and Managing Your Music 3-17

ars, listing track 

R
t
S
L

rom your player’s 
elected Music List—

io completely, tracks, 
sic Library as shown in 
e 3-12.
Playing 

4. Scroll Select Track Details. A message box appe
information.

emoving music 
racks from the 
elected Music 
ist

When tracks, albums, artists or genres are removed f
Selected Music List, they are only removed from the S
audio still remains in the Music Library. To delete aud
albums, artists or genres must be deleted from the Mu
"Deleting Music Tracks from the Music Library" on pag

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.
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move from the 

k or remove all audio 
ding step:
 the Selected Music 

genre is removed from 

ist

ears, asking you if you 
ist.

d Music List.
Playing 

3. Scroll Select the track, album, artist or genre to re
Selected Music List. A list appears.

4. Depending on whether you want to remove a trac
from the Selected Music List, follow the correspon

To remove a track, album, artist or genre from
List

Scroll Select Remove. The track, album, artist or 
the Selected Music List.

To remove all audio from the Selected Music L

1. Scroll Select Remove All. A confirmation box app
want to remove all tracks in the Selected Music L

2. Scroll Select the check mark .
All audio selections are removed from the Selecte
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R
S
L

 can rearrange the 
ividual track.

 track to move. A list 

xt to the selected 
Playing 

earranging the 
elected Music 
ist

If you want to listen to tracks in a particular order, you
tracks in the Selected Music List by artist, genre or ind

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.

3. Scroll Select the album, artist, genre or individual
appears.

4. Scroll Select Change Order. An icon appears ne
album, artist, genre or individual track.
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r individual track to the 

lected.

S
S
L

nt Selected Music List, 
d playback later.
Playing 

5. Using the Scroller, move the album, artist, genre o
preferred position in the Selected Music List.

6. Press the Scroller to set the position you have se

aving the 
elected Music 
ist as a playlist

If you like the contents and arrangement of your curre
you can choose to save it as a playlist for retrieval an

1. Press the Menu button .
2. Scroll Select Selected Music.

The Selected Music List screen appears.

3. Press the Scroller. A list appears.

When you remove 
audio tracks from the 
Selected Music List, 
you are not 
permanently deleting 
the selections from 
your player.
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 for your playlist. This 
en.

witch from upper to 
 the letter and holding 

 want. You can also use 
s or numerals, by Scroll 

th the name you have 
Playing 

4. Scroll Select Save as Playlist. A list appears.

5. Scroll Select the letters on the list to form a name
name appears in the box at the bottom of the scre

Note: When entering letters into the box, you can s
lower case (or vice-versa) by simply Scroll Selecting
the Scroller until the letter changes to the case you
different character sets, such as accented character
Selecting the Charset option on the list.

6. Scroll Select the OK option to save the playlist wi
entered.
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E
Y

U rience with EAX 
ster Live! and Audigy 2 
le in your player 

 experience audio in the 
owing Preset settings: 
e, Indoor Arena, Jazz 
ater.
wn audio without 
 the following Rate 

can enhance audio of a 
ssical, Disco, Jazz, New 
 set it from +12 dB 
 Settings in EAX" on 

, useful if, for example, 
m the following Mode 

 controls the dynamic 
 difficult listening 
Playing 

nhancing 
our Music

sing EAX Your player allows you to enhance your listening expe
technologies also available with Creative's Sound Bla
audio cards. EAX technologies (or "Settings") availab
include:
❍ Environment, a collection of presets that allows you to

virtual environment of your choice. Choose from the foll
Auditorium, Bath Room, Cathedral, Concert Hall, Garag
Club, Living Room, Opera House, Small Room and The

❍ Time Scaling, which allows you to speed up or slow do
changing pitch or distorting sound quality.  Choose from
settings: 0.50x, 0.75x, 1.00x, 1.25x and 1.50x.

❍ Advanced EQ, a collection of equalizer settings which 
particular genre. Consists of Custom EQ, Acoustic, Cla
Age, Pop, Rock, and Vocal. Scroll Select Custom EQ to
(maximum) to -12 dB (minimum). See "Customizing EQ
page 3-24.

❍ Spatialization, which enhances your audio soundstage
you are listening to audio with headphones. Choose fro
settings: Full, Narrow and Wide.

❍ Smart Volume Management (SVM), which intelligently
range of audio, providing a superior audio experience in
environments such as in a plane or car.

General information 
about EAX is 
available at 
www.NOMADworld.
com.
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cted EAX setting.

uctions.

X, select an EAX 
ith your EAX setting:

ars onscreen and is 

setting currently 

our EAX setting

e X with the preset, 
Playing 

To use EAX with your currently playing audio:

1. Turn on EAX.
2. Select an EAX setting.
3. Select a preset, rate or mode to use with the sele

This simple process is described in the following instr

1. Press the Menu button .

2. Scroll Select EAX Audio.
3. Follow the corresponding step to either turn on EA

setting, or select a preset, rate or mode for use w
To turn on EAX:

Scroll Select EAX:Off. The EAX icon  appe
applied immediately to the audio being played.

To select an EAX setting

Scroll Select Setting:X (replace X: with the EAX 
selected). A list appears.

Scroll Select the EAX setting you want.
To select a preset, rate or mode for use with y

Scroll Select Preset:X, Rate:X or Mode:X (replac
rate or mode currently selected). A list appears.
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 use with your EAX 

C
S

option lets you define 

gain. Four vertical 
r represents 
olled. 100 Hz controls 
d-range and low-treble 
equencies.
Playing 

Scroll Select the preset, rate or mode you want to
setting.

ustomizing EQ 
ettings in EAX

Under the EAX Advanced EQ settings, a Custom EQ 
your own EQ settings.

1. Press the Menu button .
2. Scroll Select EAX Audio.
3. Scroll Select Setting: Advanced EQ.
4. Scroll Select Preset: Custom EQ. A list appears.
5. In the Preset screen, Scroll Select Custom EQ a

control levers will appear in the display. Each leve
successively higher frequencies that can be contr
bass frequencies, 800 Hz and 3 KHz adjust the mi
frequencies. 12 KHz controls the highest treble fr
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croller to move the 
ost or reduction in the 

 Audio Settings.
Playing 

6. Scroll Select each vertical control level. Use the S
control knob up or down to vary the amount of bo
selected frequency range.

7. Scroll Select the check mark to return to the EAX
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S

A
M
a
E

d other useful 
stalling Software" on 

transfer audio to and 
ons on using 
ual selection or with 

 and edit playlists.

MAD Jukebox's data 
basic instructions on 
 in your player.
oftware Applications

bout Creative 
ediaSource 
nd NOMAD 
xplorer

Creative MediaSource, Creative NOMAD Explorer, an
software, are included on your installation CD (see "In
page 2-5).

Creative MediaSorce is the best way to organize and 
from your player. This chapter includes basic instructi
MediaSource to rip audio CDs, transfer tracks by man
AudioSync, edit track information as well as to create

Creative NOMAD Explorer helps you manage your NO
files within Windows Explorer.  This chapter includes 
using NOMAD Explorer to manage the file and folders
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U
M

ith your player are 
found in the 

R
T

disk or PC Music 
d tracks from the audio 

rganizer, click the 

place e: with your 

rganizer, click the 

place e: with your 

e Source window.
g the current ripping 
sing Creative 
ediaSource

Only basic instructions on how to use MediaSource w
provided in this chapter — extensive instructions are 
MediaSource Help file.

ipping Audio CD 
racks

You can rip an audio CD’s tracks to your player, hard 
Library. You can choose to rip an entire CD, or selecte
CD.
To rip a CD

1. Insert an audio CD into your CD-ROM drive.
2. If you are not already in Creative MediaSource O

Player/Organizer View button. 
3. In the Sources window, select [e:] Audio CD (re

CD-ROM drive).
4. In the Task bar, click the Rip Now button.
To rip tracks from an audio CD

1. Insert an audio CD into your CD-ROM drive.
2. If you are not already in Creative MediaSource O

Player/Organizer View button. 
3. In the Sources window, select [e:] Audio CD (re

CD-ROM drive).
4. In the Content window, select the tracks to rip.

Ctrl-click or Shift-click to select multiple tracks.
5. Drag the selected tracks to PC Music Library in th

The Transfer Queue dialog box appears, showin
status.

Rather than manually 
entering track 
information, retrieve 
such audio CD 
information from CDDB 
before ripping tracks.

Change the default 
ripping format and 
bitrate for higher or 
lower quality audio. 
See MediaSource’s 
Help file for details



Software Applications 4-3

T  audio tracks to and 

rganizer, click the 

to a portable hard disk, 

er.
 see any tracks, use 

ontent window.
and select the 

 the selected tracks.
ing the current transfer 

U
S

ders for newly added 
or you automatically.

 in the check box. 
 which you store all 

s page. 
ransferring tracks With Creative MediaSource, you can transfer files and
from your player.
To transfer files from one source to another

1. If you are not already in Creative MediaSource O
Player/Organizer View button. 

2. Click the Show/Hide Right Panel button.
3. In the Sources window, select the source device.

If you are transferring files from PC Music Library 
select PC Music Library as your source.

4. In the Content window, select the tracks to transf
CTRL-click to select multiple tracks. If you do not
Media Sniffer (see section below) to update the C

5. In the Right Panel window, click the Source bar 
destination.

6. Click the Destination Transfer button to transfer
The Now Transferring dialog box appears, show
status.

sing Media 
niffer

Media Sniffer can be activated to monitor selected fol
music files. It will then update your PC Music Library f
1. Go to Tools -> Settings ->Media Sniffer. 
2. Click Enable Media Sniffer. A tick mark appears
3. Click Add Folders and then select the folder(s) in

your music. 
4. Click Apply and then click OK to close the setting

If you are using 
Creative MediaSource 
Organizer for the first 
time, it needs to know 
which folder(s) 
contain(s) your music 
files, so that the songs 
can be displayed in the 
Content window. Use 
the Media Sniffer to 
help MediaSource 
Organizer find your 
songs and list them in 
your PC Music Library.
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E
i

ation is incomplete or 

rganizer, click the 

 to edit, and right-click 

rganizer, click the 

t to edit, and right-click 
diting audio track 
nformation 

You may need to edit track information when the inform
wrong. 
To edit information about a track

1. If you are not already in Creative MediaSource O
Player/Organizer View button.

2. In the Content window, locate the track you want
it.

3. Select the Edit Track Properties option.
4. type in the new information.
5. Click the OK button.

The track's information is changed.
To edit information about multiple tracks 

1. If you are not already in Creative MediaSource O
Player/Organizer View button.

2. In the Content window, locate the tracks you wan
them.

3. Select to edit the Album, Artist or Genre.
4. Type in the new Album, Artist or Genre.
5. Click the OK button.
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C om the Selected Music 
lists by:

rganizer, click the 

.

ic List 

e in the Selected 

C Music Library
ontent window

rganizer, click the 

ant.
st option.
reating a playlist Creative MediaSource allows you to create playlists fr
List or from the PC Music Library. You can create play
❍ clicking the New Playlist icon
❍ saving the Selected Music List
❍ saving tracks from the Content window
To create a playlist 

1. If you are not already in Creative MediaSource O
Player/Organizer View button.

2. In the Sources window, select PC Music Library
3. On the Task bar, click the New Playlist icon.
4. Type in the name of the playlist.
5. Click the OK button.
To create a playlist by saving the Selected Mus

1. When you have the tracks in the order that you lik
Music List, click the Save As button.

2. Type in the name of the playlist.
3. Click the OK button.

The playlist appears in the Sources window, in P
To create a playlist by saving tracks from the C

1. If you are not already in Creative MediaSource O
Player/Organizer View button.

2. In the Content window, locate the track that you w
3. Right-click the track, and select the Add to playli

Owing to copyright 
limitations, preloaded 
tracks in your player 
cannot be transferred 
to your computer.
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playlist name to create 
 existing playlist to add 

plete.

A
t

rganizer, click the 

 Playlists and select 

 to add.

C
p
p

rganizer, click the 

 Playlists and select 

 playlist.

D rganizer, click the 

 Playlists and right-
4. In the Add Tracks to Playlist dialog box, enter a 
a new playlist with the selected track, or select an
the track to.

5. Click the OK button.
6. Continue selecting tracks until your playlist is com

dding audio tracks 
o a playlist

1. If you are not already in Creative MediaSource O
Player/Organizer View button.

2. In the Sources window, click the plus sign next to
the playlist.

3. Select PC Music Library.
4. In the Content window, select the track you want
5. Click and drag the track to the selected playlist.

hanging the 
layback order in a 
laylist

1. If you are not already in Creative MediaSource O
Player/Organizer View button.

2. In the Sources window, click the plus sign next to
the playlist to be changed.

3. Click and drag tracks to their new positions in the

eleting a playlist 1. If you are not already in Creative MediaSource O
Player/Organizer View button.

2. In the Sources window, click the plus sign next to
click the playlist to be deleted.

3. Select the Delete option.
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U
E

e NOMAD Explorer 

C  Explorer icon .
lick NOMAD Jukebox.
ected to your 
t to set as active. Only 
e.

 Or, click the New 

NTER>.
 Explorer icon .

O lick NOMAD Jukebox.
ected to your 
t to set as active. Only 
e.
sing NOMAD 
xplorer

Instructions on how to use NOMAD Explorer are in th
Help file—only basic instructions are provided here.

reating a folder 1. In Windows Explorer, locate and click the Nomad
2. On the View menu, point to Active Device and c
3. If you have more than one NOMAD Jukebox conn

computer, click the NOMAD Jukebox that you wan
one NOMAD Jukebox can be active at any one tim

4. On the File menu, point to New and click Folder.
Folder icon on the toolbar of Windows Explorer.

5. A new folder appears with a temporary name.
6. Type a name for the new folder and then press <E
7. In Windows Explorer, locate and click the Nomad

pening a folder 1. On the View menu, point to Active Device and c
2. If you have more than one NOMAD Jukebox conn

computer, click the NOMAD Jukebox that you wan
one NOMAD Jukebox can be active at any one tim

3. Double-click the folder you want to open.
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D
f

 Explorer icon .
lick NOMAD Jukebox.
ected to your 
t to set as active. Only 
e.

 icon  on the toolbar of 

C
o

 Explorer icon .
ick NOMAD Jukebox.
ected to your 
t to set as active. Only 
e.
eleting a file or 
older

1. In Windows Explorer, locate and click the NOMAD
2. On the View menu, point to Active Device and c
3. If you have more than one NOMAD Jukebox conn

computer, click the NOMAD Jukebox that you wan
one NOMAD Jukebox can be active at any one tim

4. Click the file or folder you want to delete.
5. On the File menu, click Delete. Or, click the Delete

Windows Explorer.

hanging the name 
f a file or folder

1. In Windows Explorer, locate and click the NOMAD
2. On the View menu, point to Active Device and cl
3. If you have more than one NOMAD Jukebox conn

computer, click the NOMAD Jukebox that you wan
one NOMAD Jukebox can be active at any one tim

4. Click the file or folder you want to rename. 
5. On the File menu, click Rename. 
6. Type the new name, and then press <ENTER>. 



Creative MediaSource needs to know where your music is stored before the 
music information can be displayed in the PC Music Library view

1. Goto the Tools menu bar at the top and select Settings. Next click on the 
"Media Sniifer"

2. Check "Enable Media Sniffer". Then click "Add Folders" & select the folder in 
which you store all your music e.g. C:\My Music.

3. Click "apply" and then "ok" to close the settings page.

4. You should be able to see your songs in the PC Music Library. (Note: if you 
have many songs, it would take some time to register all the music files. Click 
F5 to refresh the PC Music Library view)"

Although the correct way is for the user to go through the Import Wizard, using 
the media sniffer would be the fastest and easiest way for users who already 
have music on the PC, which are likely to be properly tagged. 
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T

S m x 112.5 mm x 

W

M

C

B

B
(

a fully charged 
e the playback time:
Kbps

I

echnical Specifications

ize ❑ 2.99" (W) x 4.43" (H) x 0.95" (D) or 75.9 m
24.1 mm

eight ❑ 8.0 oz or 226 gms (with the battery)

emory ❑ 8 MB SDRAM buffer

apacity ❑ 20/30 GB hard drive

attery type ❑ Lithium-ion battery (removable)

attery Life 
playback time)*

❑ Up to 14 hours of continuous playback from 
Lithium-ion battery. The following may reduc

• playback of tracks encoded at bitrates higher than 128
• use of EAX effects or environments
• skipping, fast forward or reverse during playback
• using passive speakers or high-power headphones
• long backlight timeout setting (more than 10 secs)
• playback of WMA files

nterface ❑ USB 2.0/USB 1.1

* Battery life estimated for continuous playback of tracks encoded at 128 kbps.
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P Hz)
)

S
R

C
S

T

F
R

H
D

O
F

H de, Narrow, Front 

L ky Blue
layback Formats** ❑ MP3 (at 8, 16, 22.05, 24, 32, 44.1 and 48 k
❑ WMA (at 16, 22.05, 24, 32, 44.1 and 48 kHz
❑ Wave (at 32, 44.1, 48 kHz)

ignal to Noise 
atio

❑ Up to 98 dB (Headphones)

hannel 
eparation

❑ Up to 75 dB (Headphones)

HD ❑ <0.1%

requency 
esponse

❑ 20 Hz~20000 Hz

armonic 
istortion

❑ <0.02%

perating System/
irmware

❑ Upgradeable via Internet

eadphone Out ❑ 1/8" (3.5 mm) stereo minijack, 100 mW (Wi
only)

CD Display ❑ Large 160 x 104 pixel EL backlit display, in S

** Firmware upgrades are available from www.NOMADworld.com
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D

E

P audio book content, 
ata Connector ❑ USB 2.0/USB 1.1

AX ❑ Environment effects
❑ Parametric equalization
❑ Headphone spatialization
❑ Smart Volume Management
❑ Advanced EQ
❑ Time Scaling

layback Speed ❑ Up to 1.5 times faster or 0.5 times slower for 
WMA, WAV and  MP3 audio playback
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O

I
D

aning

 managing your player. 
nnect it from your 

ect your player while 
ely managing it.

tively managing your 
r, disconnect it from 

layer’s firmware.

omplete. Reset your 
firmware to take effect. 
Onscree

nscreen Diagram and Icon Guide

nformation 
iagrams

The following icons 
appear onscreen when 
the associated 
playback action is 
used.

Diagram Action/Me

❍ your computer is actively
To use your player, disco
computer.
Warning: Do not disconn
your computer is still activ

❍ your computer is NOT ac
player. To use your playe
your computer.

❍ you are upgrading your p

❍ the firmware upgrade is c
player to enable the new 



n Diagram and Icon Guide B-2

P
ning
Onscree

layback Icons
Icon Action/Mea

❍ Play

❍ Pause

❍ Forward

❍ Reverse

❍ Skip forward

❍ Skip back



n Diagram and Icon Guide B-3

S
L ning

 audio 

ed for 
that is 
ying 
Onscree

elected Music 
ist Icons

The following icons are 
commonly found in the 
Selected List screen.

Icon Action/Mea

❍ Album

❍ Artist

❍ Genre

❍ Track

❍ Track within
category

❍ Audio select
playback or 
currently pla
back
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P
I ning

k

at

nce
Onscree

lay Mode 
cons

The following icons 
appear onscreen when 
the respective audio 
enhancements are 
active.

Icon Action/Mea

❍ Repeat Trac

❍ Repeat All

❍ Shuffle

❍ Shuffle Repe

❍ Play Track O



n Diagram and Icon Guide B-5

N
I ning

sic List

k

y

egory

tegory

gory

ory
Onscree

avigational 
cons

The following icons 
appear onscreen when 
you are in the 
associated firmware 
section.

Icon Action/Mea

❍ Menu

❍ Selected Mu

❍ Now Playing

❍ Music Librar

❍ Playlists cat

❍ All Tracks ca

❍ Albums cate

❍ Artists categ



n Diagram and Icon Guide B-6

ory

ning
Onscree

❍ Genre categ

❍ EAX

❍ Find

❍ Settings

❍ About

Icon Action/Mea

The following icons 
appear on-screen when 
you are in the 
associated firmware 
section.
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FAQs and Troubleshooting C-1

F
unter or questions you 
ra. If you have a 
onsult our self-help 
olutions. Go to 

ivided into a few 

A utomatically after the 

ot be enabled.
y Computer 

omputer icon.
 AutoPlay.

cation

erties dialog box 

-ROM drive.
AQs and Troubleshooting
This section covers common problems you might enco
might have while using your NOMAD Jukebox Zen Xt
technical problem with this product, you may wish to c
tool “Knowledgebase” for online troubleshooting and s
www.creative.com and select your region.

The Frequently Asked Questions (FAQs) have been d
categories for your easy reference.

utoPlay What do I do when the installation does not start a
Installation CD is inserted?
The AutoPlay feature in your Windows system may n
To start the installation program through the M
shortcut menu

1. On your Windows desktop, double-click the My C
2. Right-click the CD-ROM drive icon, and then click
3. Follow the onscreen instructions.
To enable AutoPlay through Auto Insert Notifi

4. Click Start -> Settings -> Control Panel.
5. Double-click the System icon. The System Prop

appears.
6. Click the Device Manager tab and select your CD
7. Click the Properties button.
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rt Notification.

F  back from the 

". See "To play the 
ore information.

s in it, can I repeat 

 track, or all tracks. 

 with "B" when I’m 

r player looks for the 
ith "A", the closest 

G  products?
g to all Jukebox 
sit 

 I can do?
ned paper clip into the 
8. Click the Settings tab, and then select Auto Inse
9. Click the OK button.

eatures If I make a bookmark in a track, will the track play
bookmarked point?
No, you have to manually select "GO TO BOOKMARK
track from the bookmarked point" on page 3-20 for m

If the Selected Music List already has a few album
playback of just one album?
Unfortunately, no. You can only choose to repeat one

Why does my player show me track titles starting
looking for a track title starting with "A"?
When you look for a track using the FIND feature, you
closest match. If you do not have any tracks starting w
match can be "B".

eneral Where can I get official information on all Jukebox
Visit NOMADworld for updates and downloads relatin
products, Creative’s MP3 players and accessories. Vi
www.NOMADworld.com.
My player seems to have frozen. Is there anything
You can reset your player. Insert the end of a straighte
Reset button.
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accessories.

er is not certified. 

y encouraged 
ification. If a hardware 
icrosoft certification, a 

or update. If you do, 
n. Creative has tested 
impair or destabilize 
How can I get accessories for my Jukebox?
Visit www.NOMADworld.com for the latest news on 

Windows XP tells me that the software for the play
What do I do?
At the time of this product's release, Microsoft strongl
companies to submit their hardware solutions for cert
device driver is not submitted, or does not qualify, for M
warning message similar to the one below appears.

You may see this message when installing this driver 
you may choose to click the Continue Anyway butto
this driver or update on Windows XP, and it does not 
your computer.
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M
p the hard disk at all. 
ot have to worry about 

U
ks, such as those that 
 nice long walk with 

le data storage?
toring and playing 
B cable for speedy 
be recognized as a 
u manage data files.

 anything I can do to 

s the hard disk uses 
acity is not 

ore battery power:
erves battery power.
an read the display 
aintenance Do I need to defragment the player’s hard disk?
No, you will not need to defragment, format or clean u
The player’s unique file system ensures that you will n
hard disk maintenance.

sage Can I jog with my NOMAD Jukebox Zen Xtra?
You should not subject your player to continuous shoc
are likely to occur while you jog or run. You can take a
your player, though.

Can I use the NOMAD Jukebox Zen Xtra for portab
Yes, you can. However, the Jukebox is designed for s
audio, not as an extra hard drive. You can use the US
transfers to and from your player. Your player will not 
drive. Use the NOMAD Explorer application to help yo

I have to recharge the battery quite often. Is there
make it last longer?
Generally, any operation requiring the player to acces
battery power. Consequently, filling your player to cap
recommended. However, some operations consume m
❍ a long backlight timeout setting. A shorter timeout cons
❍ a high contrast setting. Position the player so that you c

without using a high contrast setting.
❍ too much use of fast forward/reverse. 
❍ turning the player on/off too many times.
❍ use of EAX effects or environments.
❍ use of passive speakers or high-powered headphones.
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help in prolonging 

pter?
 the player, disconnect 
ads to heat buildup, 

ilar, off-the-shelf 

yer, and may even 
 Creative at 

distributor.
Proper charging and handling of the battery can also 
battery life and charge.

Should I leave my player plugged into the AC ada
No, you should not. After charging the battery or using
it from the AC power adapter. Leaving it plugged in le
which is not good for the player or the battery.

If I damage or lose my AC adapter, can I buy a sim
adapter?

No. The adapter may not be compatible with your pla
damage it. You should get a replacement adapter from
www.NOMADworld.com, or your local Creative office/
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E g diagrams, indicating 

uggested Action

wnload a newer 
mware version
load firmware
ll Technical Support

ll Technical Support

charge the battery
e DC power

e actions for firmware 
oblems

low firmware to 
mplete the rebuilding 
 the library
rror Diagrams If an error occurs, you may see any one of the followin
the general nature of the problem.

Diagram Likely Causes S

❍ unexpected power 
loss while saving 
settings

❍ do
fir

❍ re
❍ ca

❍ physical defects
❍ numerous high-

impact shocks
❍ ca

❍ battery is too 
depleted, player 
cannot start up

❍ re
❍ us

❍ firmware corruption ❍ se
pr

❍ unexpected power 
loss during audio file 
transfer

❍ al
co
of
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U

S
P

n

C
S

ct a name.
ser Preferences

etting User 
references

Your player offers many configuration options. You ca
❍ personalize your Jukebox
❍ specify profiles
❍ set the contrast level for your player’s screen
❍ select the default language
❍ reset your player
❍ lock and unlock your player’s buttons
❍ access the information screen

hanging 
ettings 

In the Settings screen you can:
❍ set the owner’s name
❍ return to the previous screen
1. Scroll Select Settings.
2. Scroll Select one of the options.
3. From the menu, Scroll Select a setting or constru
4. To save the setting, Scroll Select OK.

To construct a name, 
Scroll Select the letters 
and numbers to form 
the name. Each letter 
and number selected is 
entered into the entry 
area.



User Preferences D-2

P

conic tabbed menu (see 

ct the Play Now option.

utomatically shuts down.
d, using the Sleep 

r using a Car Kit (see 
 itself on and off when 

tting conserves battery 

file.
 Scroll Select the left 

een, Scroll Select 
rofiles  

In the Profiles screen, you can:
❍ select a profile
❍ switch the Menu Style between a standard list menu or i

figure above)
❍ clear the Selected Music List whenever you Scroll Sele
❍ change the skin of the Now Playing screen
❍ specify the default start screen
❍ enable the screensaver
❍ specify how long the player remains inactive before it a
❍ play your favorite music tracks for a specified time perio

Timer option.
❍ enable Car mode. If your player is connected to your ca

"Optional Player Accessories" on page 1-vii), it will turn
you turn the car engine on or off.

❍ adjust the screen backlight duration. A lower number se
power for longer playback time.

❍ return to the previous screen
1. From the Settings screen, Scroll Select Edit Pro
2. Scroll Select the settings that you want, and then

arrow to exit the Profile screen.
3. To enable the edited profile from the Settings scr

Profile. A list appears.
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different profiles to suit 
 Home or Car Player).

S  time period.
file.

en.
een, Scroll Select 

C reen. The lower the 

t. A list appears.

L
S

ayer’s screens and 
4. Scroll Select the profile that you want. There are 
your needs (for example, Standard, Advanced, At

etting Sleep Timer Sleep Timer lets you play music tracks for a specified
1. From the Settings screen, Scroll Select Edit Pro
2. Scroll Select Sleep Timer.
3. Select a playback time.
4. Scroll Select the left arrow to exit the Profile scre
5. To enable the edited profile from the Settings scr

Profile. A list appears.
6. Scroll Select the profile that you want.

ontrast This option sets the contrast level for your player’s sc
number, the lower the contrast.
1. From the Settings screen, Scroll Select Contras
2. Scroll Select the contrast setting that you want.

anguage 
ettings

You can change the default language used on your pl
input boxes.
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M r’s menus are 

der Language.

I etters or characters in 
 or rename a playlist.
der Language.

T et the Wake to Music 
ast heard music track 

S
d

t Time & Date.
djust.
ase the date or time, 
enu Language This option controls the language in which your playe
displayed.
1. From the Settings screen, Scroll Select Menu un
2. From the menu, Scroll Select a language.

nput Language This option controls the language in which you input l
input boxes, for example, when you search for a track
1. From the Settings screen, Scroll Select Input un
2. From the menu, Scroll Select a language.

ime and Date This option allows you to set the date and time, and s
feature. The Wake to Music feature lets you play the l
at a specified time.

etting time and 
ate

1. From the Jukebox Settings screen, Scroll Selec
2. Scroll Select the date and time that you want to a
3. Turn the Scroller up or down to increase or decre

and then press the Scroller to save the setting.

You can also lock your 
player by pressing the 
Power button. Scroll 
select the check mark. 
The player is locked. 
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S
M

t Time & Date.
 Music icon .

ase the time, and then 

 means that Wake-To-

ying tracks at the 

A
I
S

 can upgrade the 

ic or data
etting Wake-To-
usic

1. From the Jukebox Settings screen, Scroll Selec
2. Scroll Select the time settings next to the Wake to
3. Turn the Scroller up or down to increase or decre

press the Scroller to save the setting.
4. Scroll Select the Wake to Music icon.

  means Wake to Music is enabled, and 
Music is disabled.

5. Turn off your player.
Your player will automatically turn on and start pla
specified time.

ccessing the 
nformation 
creen

The Jukebox About screen shows you:
❍ the player’s firmware version — so that you know if you

firmware
❍ the total amount of space in your player for storing mus

Be sure that your 
player is connected to 
a DC power source 
when using the Wake 
to Music feature.

If there are no music 
tracks in the Selected 
Music List and the 
Wake to Music feature 
is enabled, your player 
will play a random 
track.
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ata

elect About.

R
P

lt settings, do the 

ow appears.

R
P

❍ the available space in your player for storing music or d
❍ the number of tracks stored in your player
❍ the number of albums stored in your player
❍ the number of playlists stored in your player

To see this screen, from the Settings screen, Scroll S

esetting your 
layer’s Settings

If you wish to reset your player’s settings to the defau
following
1. Press the Menu button.
2. Scroll Select Settings.
3. Scroll Select Reset Settings. A confirmation wind

4. Scroll Select the check mark .

esetting your 
layer

If your player stops responding, reset the player. 
This should not cause you to lose any data or 
audio tracks, unless you were in the middle of 
transferring an audio track. You can check for 
the audio track in your music library later. See 
"Using the Music Library" on page 3-8.

To reset the player: Insert the end of a thin 
object (like a straightened paperclip) into the 
Reset button.
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L
u
P

ll buttons on the player 
u do not want any 
lly.

up window appears for 
 don’t use the Scroller 

T

T
p

nlocked.
ocking and 
nlocking your 
layer

Locking your NOMAD Jukebox Zen Xtra will disable a
except for the Scroller. This feature is useful when yo
buttons (for example, Play/Pause) pressed accidenta

If you press a button while the player is locked, a pop
you to unlock the player. This popup disappears if you
to make a selection within a few seconds.

o lock your player 1. Press the Menu button . 
2. Scroll Select Button Lock.
3. The player is locked.

o unlock your 
layer

1. Press any button. A popup window appears.

2. Scroll Select the check mark . The player is u

Alternatively, you can 
press the Power 
button. A popup 
window appears. Scroll 
Select the check mark.
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